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ABOUT THE ICAI

The Institute of Chartered Accountants of India is a statutory body established by an Act of Parliament viz., The Chartered
Accountants Act, 1949 in the year 1949 for regulating the profession of Chartered Accountancy in the country. The Institute,
which functions under the administrative control of Ministry of Corporate Affairs, Government of India, has five Regional Councils
at Mumbai, Chennai, Kanpur, Kolkata and New Delhi. It presently has 153 Branches covering the length and breadth of the
country, 22 Chapters outside India and an overseas office in Dubai.

Founded 66 years ago with just seventeen hundred members, the Institute has grown to cross mark of 2,46,000 members and
9,35,000 students as of now. A significant majority of our membership is in practice and a good deal of specialisation in traditional
areas of direct/indirect taxes and in emergent specialism’s inter-alia, in financial services, information technology, insurance
sector, joint ventures, mutual funds, exchange risk management, risk and assurance service environment/energy/quality audits,
investment counseling, corporate structuring and foreign collaborations. The other half was/is in employment, many occupying
senior positions such as CMDs in Banks/Financial Institutions, CEOs in leading and reputed public/private sector companies etc.

One of the important elements of the developmental role of the Institute is to make contributions to Government authorities
and Regulations viz., the Ministry of Corporate Affairs, Trade Policy Division of the Ministry of Commerce, CBDT, RBI, IRDA, C&AG,
SEBI etc. to name a few, on relevant matters of importance to the economy and profession.

On International front, the Institute, a permanent member of International and Regional Accounting bodies, like International
Federation of Accountants(IFAC), International Accounting Standards Board(IASB), Confederation of Asian and Pacific
Accountants(CAPA) and South Asian Federation of Accountants(SAFA) has made its presence felt through its effective and
sustained contribution Professional bodies like American Institute of Certified Public Accountants(AICPA) in U.S.A. The Institute
of Chartered Accountants in England and Wales(ICAEW) in U.K. and a host of similar bodies in many other countries have signed
MOUs with our Institute for professional collaboration in areas such as education, examination, training etc. and on issues
confronting the accounting profession worldwide.

The Institute, being a statutory body, is administered by a Council which is the highest policy making body of the chartered
accountancy profession. The Council is comprised of 40 members of whom 32 are elected from among its members spread all
over the country. The remaining eight members are nominated by the Central Government representing such authorities as the
Comptroller and Auditor General of India, Ministry of Finance, Ministry of Corporate Affairs and persons of eminence from the
fields of law, banking, economic, business, finance, industry, management, public affairs etc.

ABOUT EIRC

In 1952, Eastern India Regional Council (EIRC of ICAI) was constituted with its jurisdiction on West Bengal, Orissa, Assam, Tripura,
Sikkim, Arunachal Pradesh, Mehalaya, Nagaland, Manipur, Mizoram and the Union Territory of Andaman & Nicobar Islands. The
founder Chairman was Mr. Molay Deb and the office of EIRC was located in the 2nd Floor of 7, Hastings Street(Now renamed as
Kiron Shankar Roy Road).

On 10th December, 1975, the foundation stone of the present EIRC Building at 7, Russell Street (Now renamed as
AnandilalPoddarSarani) was led by the then Chief Justice, Calcutta High Court, Hon'ble Justice Shankar Prasad Mitra. On 14th
April, 1977, the building was inaugurated by the then Hon’ble Governor of West Bengal, His Excellency Shri A.L. Dias.

On 17th January, 2014, the Second State of Art Building at 382/A, Prantik Pally, Rajdanga, Kasba, Kolkata-700107 has been
inaugurated and the same is in operation to cater its dedicated service to its more than 23,005 Members and 83,690 Students.

EIRC has 11 Branches, 18 Study Circles, 5 Study Circles for Members in Industry, 5 CPE Chapters and 8 Study Groups.

EIRC has the privilege and pride in presenting 10 Presidents to ICAl and each one of them has enriched and empowered the
profession through their visionary leadership and innovative dynamism.

The cherished dream of EIRC is to kindle the spark within the fraternity and to make the members world class professionals as
well as good human beings — to contribute as an active partner in the nation building exercise.
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Chairman’s Message

Dear Professional Colleagues,

”

“The capacity to learn to is a gift; the ability to learn is a skill; the willingness to learn is a choice.

- Brian Herbert

| always had a dream to make all corners of my esteemed fraternity to cope with all the latest
technological developments, Understanding and appreciating that we professionals are left with
very little time to learn about technological advancement which our world has gone through,
hence lagging behind different know how of the IT Field. | take this opportunity to introduce a
course for our elderly professionals, 50:50 Technology for Senior Professionals - 50 Key areas
to learn in Computers and Information Technology.

Senior professionals facebarriers and challenges when it comes to adopting IT techniques. With
passage of time and also seeing the demand of the hour and keeping in mind the concept of green
initiative throughout the universe, IT know how and knowledge is something which cannot be
denied& avoided for long. In line of the same which is miles apart from the previous practices of
hard copies communications we have moved a long way in bringing the IT world in effect. | hope
this design of course will immensely help our senior professionals which will provide them with
necessary aid to deal with the required IT knowledge.

| wish to place on record the contribution and unstinted support by all my colleagues in the
Regional Council & Central Council in providing all out support for conduct of this course. | must
make special mention of CA SanjibSanghi, Chairman, Information Technology Committeeof EIRC
who has put tireless effort in making this course a reality.

Wish all the participants a great learning experience.

Date : 9th April 2016 CA Anirban Datta
Place : Kolkata Chairman, EIRC
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Chairman Information Technology Committee’s Message

Dear Professional Colleagues,

Let’s Bring Technology to our Profession. This was my mantra since inception as the Chairman of
the IT Committee of EIRC of The ICAI. Taking a step forward in this direction we have designed this
course 50:50 Technology for Senior Professionals - 50 Key areas to learn in Computers and
Technology.

Learning has no age. We all are aware that there are many people in their 50's and 60’s going
back to college to earn their degree. At that point in their life they are probably doing it because
it is something they want to accomplish. In a similar way Technology is vast changing and with
Computers now being a part of life, there are many elderly professionals who want to get expertise
in handling the same, with this intention we have launched this course to share our knowledge
with them and to make them aware what a wealth of knowledge is available online. | certainly feel
that this small step will have some impact in enriching their lives and empowering them.

| take this opportunity to place on record my sincere gratitude to CA Anirban Datta, Chairman,
EIRC for entrusting me with this responsibility of being the Chairman of Information Technology
Committee of EIRC. | would like to appreciate the sincere efforts of the dedicated team of
professionals who have worked to make this course a reality.

| am sure that the members will definitely benefit from this course and it would create some
difference in their life. | would be glad to receive inputs and suggestions for designing more of
such courses in the near future.

| would just end by saying “It is not what Technology does to us, it is what we do to Technology.
Get smart with Technology, choose wisely and use it in a way that benefits both you and those
around you”

Date : 9th April 2016 CA Sanjib Sanghi,
Place : Kolkata Member, EIRC
Chairman, IT Committtee, EIRC

; 5|5
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Research in Topics on Internet

Google
= |t is the most popular search engine on the World Wide Web, handling

more than 3 billion searches each day.
= To visit this site type
http:\\www.google.com in the address bar and press enter key (Figure 1.1.1)

e i rtmnie =Y =
4+ - C |8 hitps://www.google.co.in

ot maces 3 (KN

Google Search I'm Feeling Lucky

Google.co.in offered in. =8 TN denc Fod gUlp wadl 5o oemoge e

| Figure1.11 |

1) Write Text or Part of the text to Search
2) Click on Google search button and see the result (Figure 1.1.2)

- C | B hupssiwww.google.colin/s#g=union+budget + 201¢
Googic | union budget 2016| 5 m
An Mo idhao Imagoes haps rMore - Search tools
About 351 00,000 results (0, 3% seconds )

Union Rall Budget 2016 - indlaﬂrnes com

timesofindia_ indiatimes com/
Road Latest u wn Ay ti Arywhars on Timas of India™ Official Sital
‘..- N MNews T <ing r| Breaking Mews  India N..A-.

Fnra Arun Jailley Presents Union Budget 2016 in Parliament
VA ONCars. Ing -
Expant take on ieteat cam (i 1A With vidcs, imsgas snd monst

Union Budget 2016-17 - Find Your Mew Travel Guide
travel india com/ -
Plan a Sea. Mc wain Or Wildlife “YVac ation

B\CCIQBI 2016-"’017 Unlon Budget 2015 17. India Rallway ..
= C oMM I L indiatim com/budgetZ0i6 oms -
st 2016 Hi ;" ghta of B u st. Union nmls:nAn- 17. Railway Budget 2016
sy 2016, Live Budget News - E7 brings you 360 degres

Budgsl 2015 India Union Budget 2016-17. Live, News __.
W business-standard com » Budget -
Ir chl lJIll =1 Illl iget 2076-17 ive updates and News: Business Standard offers
o coverage " B Ir #2016 prosonted by financo minister A

| Figure 1.1.2 |
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Wikipedia:

It is the free, open content online encyclopedia created through the collaborative effort
of a community of users known as wikipedians.

Curment events
Random article

Community portal

To visit the site type
o http:\\www.wikipedia.org in the address bar and press enter key

& Notiogged in Talk Contributions Create account Login

Main Page  Talk Read View source View history |28 Q.
WikIPEDIA Welcome to Wikipedia o Arts « History » Society
bz e R yclopec ! « Biography « Mathematics » Technology
the free encyclopedia that anyone can edit ' -
Main page 5,111,555 articles in English » Geography « Science » All portals
Contents =
Featured confent From today's featured article In the news

The Oppenhel ity hearing (1954) of the US Atomic » Mahamadou Issoufou (pictured) is re-elected
Donate to Wikipedia Lt Y g :
Wikipedia store Energy Commission (AEC) explored the background, actions and President of Niger amidst an opposition boycott
associations of J. Robert Oppenhelmer (pictured). He had headed » Alleast 34 people are killed and more than 270
Interach
i I-Ililunn the Los Alamos Laboratory during World War II, where he played a injured in attacks at Brussels Airport and
About Wikipedia key part in the Manhattan Project that developed the atomic bomb Maelbeek metro station

Doubts about Oppenheimer's loyalty dated back to the 1930s, when

Retent changes J. Robert he was associated with Communist Party USA members, including President of Benin. Mahamadou
!

Contact page Oppenheimer his wife and his brother. At Los Alamos and in the AEC, he was » Barack Obama becomes the first U.S. President  “~/
Tools Involved in bureaucratic conflict between the Army and Air Force since 1928 to visit Cuba.

\What links here over the types of nuclear weapons the country required, technical confict between the « In rugby union, the Six Nations Championship concludes with

Related changes stientists over the feasibility of the hydrogen bomb, and personal conflict with AEC England winning the Grand Slam by defeating France.

Upload file commissioner Lewls Strauss. The panel found that he was loyal and discreet with « A suicide bombing in Istanbul kills 5 people and injures 36

i;:f:::::’f:k atomic secrets, but did not recommend that his security clearance be reinstated. This others, six days after the Ankara bombing kiled 37 people

Page information ended.ms rale in government and policymaking. He became an acauel?'ut exile, cut off Ongoing events: Zika virus outbreak - European migrant crisis

\Wikidata flem from his former career and the world he had helped to create. The findings were seen Recent deaths: Rob Ford - Andy Grove - Guido Westerwelle
e as fair by some and as an expression of anti-Communist McCarthyism by others.

Uex|

s e botk (Full article...) | On this day...

Download as FOF Recently featured: Nuckelavee - Plateosaurus - The Final Cut (album) _

Printable version Aok By el Mok satined irtiches.. March 24: Purim (Judaism, 2016); World Tuberculosis Day
In ather projects « 1603 - King James W1 of Scotland acceded to

Wikimedia Commons Did you know... the thranes of England and Ireland, becoming

Meia-Wikd T fife ivest ; it James | of England and unifying the crowns

Wikispeci . that Meghalaya has one of the largest surviving matrilinea

Witnecs v Gl Hieghiay v 9 of the kingdoms for the first time. B

Wikibooks societies (Khas/ women pictured)? = Exxon Valdez

Wikid . r » 1865 - The last of Maori leader Titokowaru's d

hidata » ... that the viola da gamba player Philippe Pierlot co-founded agroun
Wikinews | ; forces surrendered to the New Zealand
the Ricercar Consort, which plays littie-known 17th-century . : :
Wikiquote {iies Khasi women of government, ending his uprising.
i usic?

Wikisource S i Nk ot g - Meghalaya » 1934 - The Tydings-McDuffie Act came into effect, which

Wik .. tha us Ra ransit began operations in as ; PR i

Wikiversity = P gan ope provided for self-government of the Philippines and for Filipino

Wikivoyage the first bus rapid transit system in the U.S. state of Washington?

= _. that Ethel Wilson Gammon, founder and executive director of the Washburn-

Figure 1.2.1

« Independent candidate Patrice Talon Is elected

independence from the United States after a period of ten years

goo b tacko ap oo ot o

1) Write Text or Part of the text to Search (Figure 1.2.1)
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Emails & Instant Messaging (Gmail, Whatsapp)

What is gmail?
Gmail is a free, search-based email (Webmail) service, which is accessible from a Web browser
anywhere in the world so long as an Internet connection is present.

Create an user account

Step 1: Sign Up(Figure 2.1.1)

Sign in with your
Google Account

Username: |
ex: pat@example.com

Password:
"] Stay signed in

Can't access yvour account?

New to Gmail? It's free and easy.

r Y

Create an account »

About Gmail New features!

Figure 2.1.1

Go to: www.gmail.com
Click here to Create your Account
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Step2: Fill up the following details (figure : 2.1.2 & 2.1.3)

|Answer:

Recovery email:

Choose a password: sssssssssnse Password strength: ~ Strong
Minimum of 8 characters in lengt
Re-enter password: escsssssssss
Enter a
Stay signed in password
Enable Web History Learn More

Default Homepage Set Google as my default homepage.

Your default homepage in your browser is the first page that appears when
you open your browser

Security question: Write my own question

What city was | born in?

If you forget your password we will ask for the answer to your security
question. Learn More

Lewiston

This address is used to authenticate your account should you ever encounter
problems or forget your password. If you do not have another email address,
you may leave this field blank. Learn More

~ security

Enter or
choose a

question or
write your
own.

Figure 2.1.2

Birthday:

Word Verification:

Terms of Service:

01/10/1963 Type in your birthdate
MMODAYYYY (e.g. "97/20117) . .

Type the characters you see in the picture below.

Type in the word in the “word verification” box

|
s

ber

chertssted
Letters are not case-sensitive

@ Would you like to use the following as your home page?

hittp: /fwww.google.com/

Please check the Google Account information you 9 Us 1 wiebnage ax your aoly e peon.
to change anything you like), and review the Terms () Add this webpage to your home page tabs

With Gmail, you won't see blinking banner ads. Insti
might find useful that are relevant to the content of y
moare

You can either use
Google as your home
page or a tab on your
home page

four relationship with Google

10

[ 1 accept. Create my account. |

Click on the | accept. Create my account button
king on 'l accept’ below you are agreeing t erms of
and both the Program Policy and the Pri i

Figure 2.1.3

505D
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» Step3: Click on Show me my account to complete the Step (Figure 2.1.4, Figure 2.1.5)

Congratulations! S —
You've successfully signed up for Gmaill Here's a quick run through to help you get Show me my account» »
comfortable. _—
Archive instead of delete
Tidy up your inbox without deleting
(GMmai —_— anything. You can always search to find
what you need or look in "All Mail.”
o Chat and video chat
s Chat with your contacts directly within
. Gmail. You can even talk face-to-face
with built-in video chat.
B e | | Labels instead of folders
Labels do the work of folders with an
extra bonus: you can add more than one
—_— I 8 Personal to an email.
Figure 2.1.4
= :
| s al I Search Mail | | Search the Web B osiens
"C":“t - 55" LED TV's for $49.99 - Quibids.com - LED's, Tablet’s, Laptop's, etc. Never Pay Retail Again. Shop Nowl
niac
Tasks Elv.| |Archive | Spam. | Dolele.] |}, B.) |Movetow.| Lebelav,| | Moy, |.C.
C se mail Ll Gmail Team Import your contacts and old email - You can import your contacts and mail from Yahoo!, Hoti]
Inbox (3) 7] Gmail Team Customize Gmail with colors and themes - To spice up your inbox with colors and themes, ch
Buzz p [ Gmail Team Get Gmail on your mobile phone - Access Gmail on your mobile phone The days of needing y
Starred 7%
Important
Sent Mail
Drafts
Personal
Travel
6 more »
Figure 2.1.5
— » Notice the 3 emails that you have received from Google in your inbox

» The emails have 3 tutorials explaining some of the features of Gmail.

55150 :
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Gmail

Exchange of Message through Gmail

Composing a “New Message” and create new contact(Figure 2.1.6)

» Contacts=— Mail
» Like an address book Contacts
Tasks
» Contains email addresses & contact information
» Click on “New” or “Compose Compose mail
Figure 2.1.6
» Subject:

» Brief description\
Send Save Now Discard | Draft autosaved

» CC (Carbon Copy) *

(To include other people in an QR fan.Smii2gmad.com

email message).

> BC (Blind Carbon C :
(Blind Carbon Copy) \ Cc: brogers@hotmail.com

*

(Addresses will not be visible to \
other parties).

e Figure 2.1.6
\Bee: susanadams@yahoo.com

\

» Attach or Upload files \ J

ubject:

» Attachments

Meeting tomorrow at 2:30pm|
& Attach a file

Figure 2.1.7
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Draft or Send
Send Save Now | Discard = Draft autosaved

> Draft:Save it to send lat

To: | jsmith@gmail.com

> Send
Add Cc | Add Bec
(Click only when the message i Subject: Meeting
and ready to send.) & Attach a file

BZ UFTEHTD - @ = i=

Tomorrow's meeting for the board will be at 2:00pm.

Thanks

\ Phil

N

Send Save Now Discard = Draft autosaved

Figure 2.1.8

Inbox: For Incoming Mail Check(Figure2.1.9)

Mail
Contacts
Tasks [“]w | | Archive Spam | Delete | [+ | [= Movetow Labels¥ = Morew

33 33 Overstock Laptops? - QuiBids.com/Blowout - Today: Website Selling Laptops l’

Compose mail [[] Y% Fecteau, Alan [ meeting - Would like to set- up a meeting 4

Inbox (1) [l McKenney, Janet Meeting? - Can we meet tomorrow at 2 PM

Buzz Q
Starred 77
Important
Sent Mail
Drafts (1)

Figure 2.1.9

Shows all incoming mail you have received

» Click on the email to read it.

> All unread emails are usually marked in bold text

50/50) :



Reply or Reply All

Respond to Incoming Mail(Figure 2.1.10)

» When you want to respond to an email, Click l{ere

50 : 50 Technology for Senior Professionals

New window will appear to
compose your message & Reply
All. The message will be sent to all
parties in the email.

Compose nigi

Inbox (2)
Buzz @
Starred ¥y
Important
Sent Mail

Drafts (1)

Maine State Librar...
Personal

Travel

6 more v

Chat v =

Search, add, or invite

|e Patrick Therrien

Inbox | X

Meeting?  |x
McKenney, Janet Janet McKenney@maine.gov

Can we meet tomorrow at 2 PM?
In the MSL Studio?

Thanks,

Janet

Janet McKenney

Director of Library Development
Maine State Library

64 State House Station
Augusta, ME 04333

207-287-5620
207-287-5624

Set status here v
. Call phone “Reply ~* Forward
Figure 2.1.10
Forwarding an Email
> Do you want to share an email message |Meeting? [ Inbox | X

with another individual?

You can share an email message with
another individual by Forwarding it.

14

Thanks,
Janet

“ Reply

McKenney, Janet Janet McKenney@maine.gov

Can we meet tomorrow at 2 PM?
In the MSL Studio?

Janet McKenney
Director of Library Development
Maine State Library
64 State House Station
ugusta, ME 04333

=¥ Forward

Figure 2.1.11

50/50)
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Whatsapp

WhatsApp is a play on the casual greeting “what’s up?” It is an ad-free mobile messaging app that allows
users to exchange text and media messages through their Internet data plan or through Wi-Fi. Users do
not have to pay for SMS. Once you start using WhatsApp to connect with your friends, you'll wonder how
you ever lived without it!

Download WhatsApp (Figure 2.2.1)

*The app is available on its website and in the iTunes App Store and Google play Store.

Launch the app from your smartphone.

e
gt iwtive
gy b TS mobile &
ﬁ?ia m,‘l.n;.. may saki, Mobile L >
Nicole W motitie ©
»':‘ate*-.-,.,-,,,” AR mobile Q
Nowee Smimmrs oiner ©
?"'"""?‘""",r torn, Mobile &

| Figure 2.2.2 |

Follow the onscreen prompts to create a WhatsApp account that will be linked to your phone number.
Allow WhatsApp to sync with your Contacts to message people you know with ease.(Figure 2.2.1)
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lalhe i 4 0 g
Abbie = mobile &

Hoy there! | am using WhatsApp —

_K.il"lg TeRE mobile o

Can't talk, WhatsApp onby —
L S z

Roi L mobile &

Wala. umalis. nagialaba. may sakit —

Figure 2.2.3

Tap "Status" in the bottom horizontal navigation bar. Tap the "+" in the top right corner to add a new
custom status.(Figure 2.2.3)

You can edit your current status by tapping the button under "Your current status is:" or selecting a
default or previous status from the list below.(Figure 2.2.4)

Select your new status

Available

At school
At the movies

At work

Figure 2.2.4

Invite Friend Tap on the "Contacts" tab in the middle of the navigation bar. Find a contact and tap on it to
view its details

50150
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Your current status is:

@instaxfilm >

Select your new status

Available

Busy

At the movies

At work

|
I
| At school

Figure 2.2.5

Start a chat. Tap "Chats" in the navigation bar. Tap the pencil icon in the top right corner and select a
contact to start a new WhatsApp message with.(Figure 2.2.5)

Broadcast Message | New Group

Ella 4:54 P
rpe >

i Figure 2.2.6

Wait for your message to be delivered to your friend's phone. One checkmark next to your
message means that it was delivered to the server, and two checkmarks mean that it was delivered to
the recipient's device.(2.2.6)

il Globe = 12:52 PM (& © 11

fast seen Wed at 17:46 PM = |
| e il Il  Edit { — info__
T m_ar.;sa“ SR
4:55 pr] - Hello!
. Hello L 11242 PM
&C V&SP Figure2.2.7
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Keep in touch with Friends, family and Clients

Face Book

It is a free popular social networking site that allows register user to create profile, upload
photos and videos etc and most importantly to keep in touch with your friends, family and
colleagues at any time and from any part of the world.

The following simple steps will help you to register as an user of Facebook.

Step 1: Create your Account (Figure 3.1.1)

facebook

Sign Up

It's free and abways will be

Figure 3.1.1

AT BARTEEEREEER | T
L= Y- tpe

L 8 by www.facebookcom =
facebook
Facebook helps you connect and share with the c reate an account
people in your life. it's free and ahvays will be
. o > 5 . =
2 B — 2 8 First name imame
2 i o
e -
> 4 b 2 Re-onter email or mobile r

Croate an account

Croste & Fage tor & celulbeity, Band o business

Aneu rmste Adverl  Comals Page Dewvelopers Camsers  Privecy  Coolies  AaChoses B

Figure 3.1.2
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Step 3:Now start work with facebook account - Add friends, Upload Photos /Videos, Chat

with your friends, colleagues and relatives (Figure3. 1.3)

€ wiieg @Eﬁ ) Facabesh
P ]

B g eeww. facebook.com

| o SRS
Ed sonFiote

Search Friend, Group,

FavoETES

Application etc.

HARA
] - " T . Bupats Branscnans
& mariagen :
T Eveen P - | . . [ R .
Ares - ol Luna .
- ) T [——
i . Ry e z
W vowcat Crunet st
W Pt - n Dtveran s ;
" Suggest fon
&3 reim — I aarta Hoy
£ Games Fesd B Coniien Frinnd a Dwapak Mumar Tiwvast LISt Of
GHOUPS <
& Ananda Draray € 2 Friends to

!+ ==nno biana of

“ Drepar sana u A Misha e
¥ B COnTHE Fruna m St Bitinn s

- ﬁ' st Chowahury
i Mwira By
“ Uetita Danees =
‘!} [ronpe———

&7 wwwatiovenm  20-
e Chat
S LAL MOLUID SAN 2=

3 Ouily Aoutine Updamm 1o
[ = IR
5 Crasie Genue

[T
& Famey
o Lis [ J— o+ Sharm =
e B s o
7 Ciosa Fraras | o

e e T -
W Universty of Caxula E : C ot
- The sttute of Gt — i R T aa . Rana Ovas .

i MeATi Eastimngall 5on 11 Subhases KRanis - o Amaton i . m B

" Pacws Fewo e amazon india e Liks Page p— | I Hiatus wans Chat Window
[ ke Pagen - " -

H Crasm Az WnNING againat all 63ds CNACK Ut More FroalimAZoARiones Ltold Rete

T Cream Page R Hamzn W LNDASY

Step 4 : Sign out from your account (figure 3.1.4). Don’t miss to logout after you are done.

© i e Pagali 9 B 5 et

+ -+ © B hpsswwwilacebook.com

T st unay G Upaste Status [ Acd Phetavides [E] Create Prote Alsen - E Blasmon Dy L

B Fot Potie =
[rYr— m —

FAvOIITES E WTLATS G ot s - NASA 1 Cruate Fage

. News Feed - |

B veseages 2 = Tamomi |

T Eweon Ll "~ | 4

i Jusgwn |
n Dhiman Mitra Sachin Tenduikars photo

arwy
B cames
L, Pt Promects.

W owzat Coonet
@ Frons

o Faceboos m Arwt Dotta
' ‘ Dranan laes .
" Bugges fam - - 1 Fewan feos = -
ppenea 2 il e &
" - - [T—] 3 o e -

GEours
& Anarda Onaray B - u Artuys W nenss
w0 wwaaAveAIn  20. 7

St i Lot 7 P
el = ﬂ'- Reatiex Gromdhury
i LAL HOLUD SAN.. 20-

" Pewmia Wy

“ Lssma Banenes
.‘q At Emangat Sen
[ PO
B o s
n Mana Dutts

s
M Eantgen Sen 4nes SULRESES e he AN Ivie 3 e ane

¥ Cany moutee Upoee 1o
I o ey ¥
T Cieats thous
[

o Famey

@ Vowran itia Arma

W Cree Frenay

& Univeraty of Caltuta
o The ammae of Cna

=)

| Fages Feed . Amazon inaia e Like Page Engaan 1 i frat Sama
Y 15 v - ~ oo v -
B0 create aa Winning aganst al oods. Check oul More STeatamazonsiones unfold nere

Crmate Page hitpfiamen to/1LUNDasy

Figure 3.1.4
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Skype is for doing things together, whenever you're apart. Skype’s text, voice and video make it
simple to share experiences with the people that matter to you, wherever they are.

With Skype, you can share a story, celebrate a birthday, learn a language, hold a meeting, work with
colleagues - just about anything you need to do together every day. You can use Skype on whatever

works best for you - on your phone or computer or a TV with Skype on it.

Let’s get started.

We need to download Skype from the internet.

You can search download Skype in Google or you can go to this link directly -

http://www.skype.com/en/download-skype/skype-for-computer/

And just click on download and it will download to your computer. (Figure 3.2.1)

15} Download Skype for Deskacy x |8
€2
5 Mot Ve Gettng Stated | Semgeted S Web Shee Gallery

==
Computer

Mobde
Skype for Windows

Download the famiflar app with all of Skype’s leatures in one place.

ypecom o7

Tablet Home phones

. Get Skype for Windows &

With the Skype app, you can do more together

' Message, voice and video call, all from one app.

¥ Get everyone together with free group video calls.

Open the
Link (1)

-2 - I ]

More devices

Click to
Download (2)

« Send pictures and files, or share your screen.
¢ Trandlate your calls and messages lo speak with amyone around
the world,

Or you can Preview Skype's integration on Windows 10.

Try the Preview of Messaging, Phone and Skype video apps today
which enables you 1o make quick free calls and send messages
without needing to download anything

Figure 3.2.1
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After downloading Skype install it in your computer using wizard as given bellow (Figure 3.2.2)

= |

Mot far to go now... Setect your largpaage
Vi st 3 o stwpn sy e g Siype rgme

Fat htire cpiates Siype sy sutormste sy metsd

v ot e b g TR ahe o g

2 de arythng

v s, o g - - e

Skype Click to Call

Maike s ot of Sieype whan brvunng e web

¥ it Shype Clci s Col

= Installation Wizard (3)
3 == Check options and
{Skype} P click continue to finish
the installation.
Make Bing your search engine and MSN
Ihomepage.

your

ew MO weathar 2 e $am s Enoets

Gl Grut sewch reauits bom g e the Lnkest
Sources meth the nem M

Uaks Bing =y sawrch angoe
Mk MSH my homepage

b et st Frpton, e e St

Installing Skype

Fhanss wnt whsin Sirype s gtated The my ke 5 v mrutes

Figure3.2.2
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Once you installed it you will see a screen as below.

Now you need to enter either Skype names or email or mobile no and password or if you don't
have any click on “create an account” or if you want to sign in with Facebook there is an option also.
(Figure 3.2.3)

Sign in

with Skypé o

Enter Skype Name, email or Mobile
Number for Existing users.

Create an account “Create an Account” for New Users.

Problems signing in? f Sign in with Facebook Option to Log in with Facebook
Account for New Users.

Figure3.2.3

Now in following window (Figure 3.2.4) we will see how to create a new account by clicking on
“create an account” option as directed in above picture.

Create an account or sign in
It only takes a minute of two - then you're ready to call your friends free over Skype, and even talk face-1o-face on video,

Firtt naener® Lt mana® \

] B

Your el sddien® Repwat ernad®

| parthasaha007 @gmail.com 4 ' I m:r.ml(wn -

Profike information >~ <———— | Fill up the Details
Berthatary |ls EHJME Tesr | 1989 Zi

Country/Magon® |_In¢~l E

o [ottma .- J

Language” | English H

Saype Narme®
| parthasaha93? -]

' : <——— | specify Skype Name
:m.... 7y S and PassWord

Ericermm, mre Sbcut P procucts. Sestisnes. and special ofier. You can opt out 31 any Lme by visiting your
serount.

] oy e

Figure 3.2.4

Eiter the characten you ee
e | Ao

22 allbl&lﬂ)
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Once you have successfully created your Skype Account, Login as directed in the penultimate picture
you will see a screen as below asking for setting up Skype. (Figure 3.2.5)

Selting up Skype
Check your sound and video

0 Speakers - can you hear the tesd sound?

‘ Setup Webcam

Setup Speakers > [spesken Meaten High Detinon Audui =

| * Treat sound

@ Microphone - can your voice be heard?

Setup Microphone

Create an account

A Can't detect your sound card

Problems signing in? f Sign in with Facebook

Continue | —>

Figure 3.2.5

After you have set up your webcam and Microphone go ahead and click on continue. (Figure 3.2.5)

You will see the next screen like below. Where you may add a profile picture or skip it by pressing add

later or continue. (Figure 3.2.6)

Setting up Skype
- a ® = b Add a profile picture

Sign in

Add Picture

Your profile pcture v how people wil tee you on

Skype. B's much easier for your friends, family and

coleagues 1o find you when they can see your
v picture.

Add e olde picture 30 e fnd the nght
| Your user name -y -

¥ou can easdy update your picture later,

Create an account

 Sign in with Facebook Click to Skip

Figure 3.2.6

To Add a profile Picture:

To add your profile picture you can go ahead and use your webcam or if you have any picture saved in
your computer just click on add files and select your favorite one and click on continue. (Figure 3.2.6)

5DI5®
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Setting up Skype a’
Add a profile picture
Take @ pecture of yoursell with your webcam, of
bromie for & picture on your computer.
o O
S—
Four previowt patured |
z 2
Problerms signing in? L Click to finalize your | [ nemnpiaine |
icture
P Figure 3.2.7
Click on “use this picture”to go to next and final stage. (Figure 3.2.7)
) S~ s
Setting up Skype ’
Sign in
i Voure 2 1ot ep andd ready 10 09 pour frimde, family andd coSeague and itart making woics and video Call.
Sumit
° o O Onkes
rig Click to finish your
- , - TORD AM ndpta, A Bemgal I
account creation
AP, and start using
Skype
[ g sevme]
Figure 3.2.8

The following is the home screen of Skype and the main parts are marked in the given picture.
(Figure 3.2.9)

i

Tga st <& Your name and

@& boring
status

Add new friends

Q, Search

# Home ® call 4+ New

CONTACTS RECENT
T |
 Jonathan

==

Dialer

[}

Figure 3.2.9

Y KingDingeLing

3\

B teal Conti
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In the following screen you will see how to communicate with your friends & family using skype. Click
on any friend’s name from the list and use the marked options. (Figure 3.2.10)

Skype Contacts Conversation Call View Tools Help

fﬁg Sumit M

© boring
Gmail for Work

Q. Search

' # Home B call + New @ Beo_ ) i Video Call "'% o o @
Away | kalyani, West Bangel, India

CONTACTS RECENT /
All « i -
Audio Call

@ Beo

Echo / Sound Test Service

Add more friends in chat

l ©

James Moreland

@ knightonlineseller knightonline...
(4] Type text
@ Lods message
me lol' via Skypy™
ol
skrill 7 A A 4
E —_— e . e e o e e e e e Pl ﬁ AL FAl Fal ?7
Figure 2.2.10 o Egl
Send Files
Send videos
Send Contacts
Send
Send Smile
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Plan your Travel and Shop Online
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Gone are those days when we needed to queue hours before the reservation counters or you
wait to take out some time from your busy schedule to buy some books, gifts or somephing

for your self.

It is only because these can be easily availed from laptops, mobiles and PCs itself via various

websites namely

i) WWW.irctc.co.in il

i) www.goibibo.com . | For online rail/air ticket booking
ili) www.makemytrip.com

iv)  www.amazon.com =

v) www.flipkart.com — | For Shop online

vi)  www.bigbasket.com

Railway Online Reservation

Now let us learn how to book a ticket using http:\\www.irctc.co.in

Step 1: Create a new Account

' “) IRCTC Next Generation eTi... xm
Type www.irctc.co.in

% | & Indian Railway Catering and T... {IN}) | https://wwwirctc.co.in/eticketing/loginHome.jsf
g P g/log J

{8 Most Visited [} Getting Started { } Suggested Sites {_; Web Slice Gallery

In address bar (1.1)

Indian Railway Catering and Tourism Corporation Limited

A
(NJ A Government of India Enterprise

Mood—on—i’rsck %dmll Cab / Bus MRCTC OYO Hotels  E-Wheelschair  Flight Tickets = Accommodations¥  Mobile App!

Train/Coach Booking (FTR)  National Voters' Services Portal

Launch Rail Budget 2016

Booking and canceliation for all Node will not be available from 00:15 hrs to 03:15 hrs of
22/03/2016 due to maintenance activity. Inconvenience caused is deeply regretted.

Booking and canceliation for all Node will not be available from 00:15 hrs to 03:00 hrs of
20/03/2016 due to maintenance activity. Inconvenience caused is deeply regretted.

Booking and canceliation for the trains originating from Delhi Node will not be available from 00:15
hrs to 03:00 hrs of 19/03/2016 due to maintenance activity. Inconvenience caused is deeply
regretted.

Due to maintenance activity User registration will not be available for time being.

Booking and cancellation for the trains originating from Mumbai Node will not be available from

UserID:
Password
Capicha

Captcha letters are case sensitive and to be entered in

Upper Case only

X  C©

DRequest oTP

Forgot Password

Sian up

NGeT Agent Login Agent Login
Mumbai Suburban Season Ticket

26

Click here to create a
new user account (1.2)
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[ Facebook- Log
€« ->CH
i Apps [} ICAlzlogin Page I YouTube JE hitp//tdssmartwebe [ facebook [ ircte

B indian atering and Tourism Corporation Ltd fiN]

cketing/usersignUp.jst

[l;!immiz

Indian Rallway Catering and Tourism Corporation Limited

A Govermnment of [ndia Enerprise

A
&y

Train/Coach Booking (FTR)  National Voters’ Services Portal
[
m e to maintenance activity user registration will not be available for time being.

gmd-on-hm ﬂ&dmll Cab | Bus é’l;mcovouonn EWheelschair  Flight Tickets  Accommodations”  Mobile Apps  IACTC Tourism ¥ IRCTC PrePaid Card¥ ahopon&muonv

Centre For Railway Information Systems m
{n rpisaen of th Misisey of Ry Goms of k) VRIS

Contact Us

ED tome

r Individupl Registration

* mandatory

User i is Available.Please go ahead with the Registration Process...
GARBAGELUNK VALUES IN PROFILE MAY LEAD TO DEACTIVATION
Please use a valid E-Mail ID and mobile number in registrabion

UseriD* das_kundu

Check Avalabilty

Password®

Confirm Password*

Security Question*

0 character Only latter, number and underscore are alowed

What is your all time favorite sports tsam? v

A& _Dowcioad 105 "'_:f:
Field mark with “*”
indicates mandatory

Secunity Answer* nda
.

FI||-up the Pref Language" Englsh ¥

Personal Details
. —9—-<

Requlred First Name * vewed
Middle Name Optignal)

Details LastNane hanss

(1 3' Sancer ® Male Female

.
il Sxanes ® Mamed ' Unmarried
Diate Of Birth* OTw JUL v 1384y
Professional v
Aadhaar Card No Cptonal
PAN Card (0
Email* kundubswaRé 2@gmai com
Maobile* +015830058617
—
Nationality* India v
Residential Address
FlatDoorfBlock No.” 201
Streellane guitandal lane {Optional) “
phone 8630068617
0 e loofice A [ ves © No
U3~ :
i Fill up the captcha (1.4)
Type code shown UHAST
Capicha letiers are case sl

Choose

RCTC Newsietier

Subscription to IRCTC New letters! F

necessary
option(s)
(1.5)

ARCTC SBICard through

Submit Registration Form>>>

Click here to
complete
registration (1.6)
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[ IRCTC Next Generation ] X

& Indian Railway Catering and Tourism Corporation Ltd N} | https://www.irctc.co.in/eticketing/hc T =
~ n
Indian Railway Catering and Tourism Corporation Limited Centre For Railway Information Systems [R#d |1
( NJ A Government of India Enterprise {An ergaruzation of the Muustry of Raldways Covt. of Indsa) CRIS

Welcome kunal kansi das

Home Contact Us

Mobile and Email Verification Process

Dear Customer | Your Mobile and Email Verification is not completed kindly complete it in below to usa the services

Mobide * Ecit Moble Mobile Number Not Verified X

Verify your

mobile number —_— e EotEmal  Emaikd Not Verified X
and emai' id [1-7) Verity Emadl id with OTP

[ IRCTC Next Generation 1 X

C f

& Indian Railway Catering and Tourism Corporation Ltd IN | https://www.irctc.co.in,

serSignUp.jsf

N jndian R Centre For Railway Information Syst ]ﬂ!’ﬂ*":
n Railway Catering and Tourism Corporation Limited entre For Rallway Information Systems
( ud A Government of India Enterprise {An ergarumation of the Muustry of Ralways Gova. of Indsa) CRIS

am.on Track ﬂmmu Cab | Bus %C‘IC 0YO0 Hotels E-Wheeischair Flight Tickets Accommodations™ Mobile Appa ¥ IRCTC Tourism ¥ IRCTC PrePaid Card¥ Shop on Amazon'¥
Train/Coach Booking (FTR) Mational Voters' Services Portal

Thank you.
You have been successfully registerad

Check the Your user regtration confrmation mal has besn sent 1o your ragistersd mail it

5 Fiease click here to login and activate your account
confirmation of _—
your account (1.8)

Step 2: How to Book a Ticket Online

&= | P | @ Indian Railway Catering and T... {IN] | https//www.irctc.co.in/eticketing/loginHome.jsf

{8 Most Visited [ | Getting Started { | Suggested Sites { | Web Slice Gallery

-, Indian Railway Catering and Tourism Corporation Limited
( NJ A Governmeant of India Enterprise

RCTC OYO Hotels E-Wheeischair Flight Tickets  Accommodations¥ Mobile App

%o-on-rmk %droﬂ Cab | Bus

I
Train/Coach ing (FTR) i Voters® 1 Portal

Launch Rail Budget 2016

Alernts & Updates View All §j Login
Booking and canceliation for all Node will not be avaitable from 00:15 hrs to 03:15 hrs of

Enter your ID and

22/0372016 due to mai activity. caused is deeply regretted UseriD . BABANS01 Password &
Fassword sesssess e————_‘

Booking and cancellation for all Node will not be avaitable from 00:15 hrs to 03:00 hrs of - XGF

20/03/2016 due to mai activity. ience caused is deeply regretted Captcha = Captcha (2.1)

Captcha letters are case sensitive and to be entered i
Booking and cancellation for the trains originating from Dehi Node will not be avallable from 00:15 Upper Case only

1rs to 03:00 hrs of 19/03/2016 due to activity. In caused is deeply m—__
regretted

1 Request OTF

Due to maintenance activity User reg will not be Bable for time being.

Eorgot Password -
Booking and cancellation for the trains originating from Mumbai Node will not be available from sian m_ Click here (2.2]

NGeT Agent in Agent in

M ai Suburban n T

: 50150
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y “. Indian Railway Catering and Tourism Corporation Limited Centre For Railway Information Systd
( mJ A Government of India Entarprise | An erganazation of the Mimistry of Railways Govt. o

Vislzome SUGH

Services  Enquiries My Transaction My Profile 30-Mar-2016 [10:42:5415T] (@5 Home | Feedback | Sign Ouf

IRCTC OYO Hotels ~ E-Wheelschair  Flight Tickets  Accommodations¥  Mobile AppsY  IRCTC Tourlam ¥ IRCTC PrePaid Card¥

TrainiCoach Booking (FTR)  National Voters' Services Portal

Pian My Journey  Quick Book

= D TALK AND SURF UNLIMITED
rrom St [OSRRRTLT airtel AT JUST 2999 (Get now | E-—_-L; |I@

To Station® DELHI- DU

Joumey Date® 14-04-2016 = fresh’ button else your session will be logged out
T:_:_xn:;;z-e_w-m w:m o _& Enter “From Station” & fransactions done before 20-3ep-2015 Click here
TN ; : Booked Ticket History (New
“To Station” and Specify v ( )

[T rn book in special concession.

Bt | Date of Journey (2.3) Booked Ticket History (Old and
= Mobile App)
sed by Google
TDR Print Ticket
Click here (2.4)
Welcome SUGATA BHATTACH

2N Indian Railway Catering and Tourism Corporation Limited Centre For Rallway Information Systems m
( HJ A Guvemmen! of ks Enlergrise 12 espunmanne of e Mty of Baeays o of 1) CRTG
VOmE SUGATE BHATTACHARTS)

Enquiries My Transaction My Prodile

FoodenTrack [ E-Bedroil | CablBus 5 IRCTC OYO Hotels | E-Wheelschair Flight Tickels  Accommodationsy  Mobile Apps¥  IRCIC Tourism v | IRCTC Prefaid Cardy [ shap on knazsay TrainiCoach Booking (FTR) ~ National Voters Services Portal

Blla Bla Car Trusied Ridesharng

e oy L5 HOWRAHIN  [DELH v Everyday £k st | /&
From Statiza® [HOWRAH N - b . 4| ..
To Station® DELHI - DU 2

IRCTC OYO Hotels: Starting at Rs. 999/
Jounay Date® 201 -

Ticst Type® E-tickat |
sty ] ) Free Cancallation” 11 Froe Breaitast ¥ FreeWR AL Rooms m v

i ook in special concession

e | e |
SICALLY HAY Chici o & Class o et Avalabiity and Fae®
Journey Class.
e e o From To Arrival Diist.{Km]) Travel Time ') T | W | T F 5 5 Class
Mol uw@aFs HAH 085 NoLs  lonas | 2 ¥ % v |y |nnus
Trin Types HVH _Iﬁ'!é NB!.S .!iﬂ .1563 03 v v J."_.o‘ ¢_J.‘_#S;
= SDAH W NDLS 0 1452 mis o W | | [TARER
%MDM T WDLS (00 1 108 VI v lele 2R
¥iourotro s 18 nots  nm  um ) ¢ R v v % %lv| i
Wlomsens [ 10 U e wae 908 v v |v|v|v v fuanazs
_——; (KoM 133 AT e s 35 AL A AR i
SOAH Pk DL nss 180 B S AR AR | x Rk E
¥ wouscam pomy
] vowmas n
¥ seatnas jsoay Click on specific class of a
\ Train Name from the list
to book a ticket (2.5)
Optionally Specify
Journey Class, Train
Types, Station
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2, Indlan Railway Catering and Tourism Corporation Limited

( ] & Govrmmest of inda [ starpnee

Centre For Rallway information Systems m}'{
A snan o e My o R Sam i) C RIS

s, SUGT BT TACHANTL

I Frunitle with e
Ticnat Tyza® E-tmin [=]

Click “Book Now” as of
your preferred date (2.8)

Seat Availability details
of specified date and
some future dates (2.6)

I ) RasCeas

Comfrm vailability on dltemate s

Contam vaitatilify n Atemate tvses

Check Fair Details (2.7)

Fare Traen Humber. 12361, Class © 14, Date - 2042096

I -T:mwnm;umwn:

Feotmeg oM @ ren mtgw of AL 18 Szumee # S2m A

Enter Passenger Details

(2.8)

30

Passanger Dotals Swwct Tour lreesl Lot Swect Mmasngar From Yoor Viese Lot

bkt ) ol oo e o S Sl [

1 |soas & ml’:].cwm =1 Ve Bl W] | [==l Cl:l
1 s |aoas 55 ||/romme ]| /ower [ |iNonves ] | [ |(ma =l i |

il e e R T = e

4 I seiec [] Normtmmnce [ | mes [ [ || bes =i ]

5 seec [ momemence [ zees [] [ ] e [zl e |

& I Seez [ ;am .[:| _suec =] | o “|:]:_ _:

-
mm!m"“um""m Barth prefierence doss ot Guarantes aliobmeant of prafarnad Derth tyse.
= It you ness assured Lower Sertns o (msame
‘-‘J Mons SOBCH), Diase SEACt ONe OF the OOtONG
) P None' 'S SESACtAC, the DArthE Wil DE SS0TTAC DaseS O the SySTam logic, depending
’:_J Boak , onty it all berths are aiotted in same Coach ;nv;!!rum&;’nﬂm:e b il :
Baook, aniy T ieast 1 lowes bertn ks aliotted This cnoice Shall not D ANJNCANE I CASE CONITMAD ACCOMMACETION 15 NOT AvaiaNe
i the train
Book, onty W2 knete bertis e afotted Sooicng snall be done i PAS inthe coach given by the uter P seats are availiabie,
E prise the passenger is aliotted In &y other coach.
N N |
| Type captcha (2.9)
» Number . S007TSE20S0

CMmcamm

Capecha lemers are Case sensiive and 10 be erened in Upper Case only

=¥ The 1D card wili

Bamw ez ook with shosogragsy'Tradins Cards 33uss oy Sanka with iaminatsc
are requined ot the time of Tt bogieng. ™

=179 3Ty remson, The MESATETION GUTDUT DETENS 27 NOT SNIAEYSS ON YOUT SITEAN BMAT yiOU ABVE MACE J&yTMANIS, B CRETK INE SeTaTs in Booxed Tickets unoer Bodkng Hstoy
IS NanGATION DT, You Msy 850 CHACK your mal for the 08NS Of yOUT DODENG. YOu 878 850 A0VISAT T0 CONTACT INTan RaEways DETOre Trying 10 DOGK your TICKeT again.

be required during journey. One of the passenger booked on an e~ticiost shouid heve any of the mine identty cards [Voter Photo loemtity Card / Passoort / PAN Card
Driving License is5wed Dy & RTO/ Pnoto 10emTy card Ssvued Ty Cantrad [ State GOVt / Stucent ’W Tosrtity Carg '65# = L 4

a, certs; Nationaized
L

OFF f Urigaes 1 Carg

U0 S —

jp=ntcacion detads

Click here (2.10)
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Check Information

You have choosen for Senior Citizen concession.
Please carry a proof of your age while travelling to produce on demand.

Check Passenger and
fare information

Traim Na Name 12301 ) KOUKATA AT Cus FRET A

From Haton : ST N [ NEW DELHI-NDLE Coucts : GENESA_
Boarding ktSon AR N - A rvston Upi NEW DEv -NDLE
L %o, | Mame Age | Oenset | Eariy Frafersace wen | Bamior Cizen WaSonsily D e /D No.
1 SOAS s | [ | 8 Veg | Yes roia
z ADAS £ 3 | Femaie | B o Veg o roa
Avamssngy A E0001 Tishst Fars - LT
Avalishimy AL Wea e 30 111019 ST 2018 ST - Cmarge fmat of Ba P— masa
Ttai Fars 7 782030
= Tioked fare inoludes Bervios Tax of N 26300

) st o ot im0 a0 Assosinims © rosnrnzem
. (;) Wijayn Bam @ Ax) b Barn
@ ccimem O imsunina o

Select Payment Mode [ prm— P T pe——
(2.11) © vesmam 1 © seset 1w mam 112 L © sout ssin mam
o Fa 10~ = Benate T 88 SOCHCatie
| mummﬁ
Select Bank (applicable
,;:- - in Case of Net Banking)

| (2.12)
Click “Make a Payment”
(2.13)
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P

(l B A& aasankidm hittps://shoppingicicibank.com/corp/BANKAWAY e m = Google

18 Most Visited || Getting Started | Suggested Sites |} Web Slice Gallery

ICIC1 Bank Home | AboutUs | Stemap | CustomerCare | F|

ﬂ ICICI Bank

PERSONAL BANKING PRIVILEGE BANKING WEALTH MANAGEMENT PRIVATE BANKING NRi BANKING CORPORATE BANKING BUSI

@ ICICI Bank Savings Alc | Pockets Wallet ' b2 - branchfree banking Alc

£ Payment through ICICI Bank May | help you?

Log in into your bank serto | R R

A/cto make payment  |———>|  Password
(2.14)

) Password? Gel Password

Payments made through this facility cannot be stopped or modified.

Log In Again to Check the under Mentioned Options:

Eﬂsm Corporation Limited Centre For Railway Information Systd

iAn of the Mimstry of Rail [

Wielcome 5UGH

[CTC OYO liotels ~ E-Wheelschar  Flight Tickets ~ Accommodations¥ ~ Mobie Apps¥  IRCTC Tourism ¥ IRCTC PrePaid Card¥ Shop on Amazon¥

jrtai

9 TALK AND SURF UNLIMITED
S em L3

Please do not press ‘Back’ or 'Refresh’ button else your session will be logged out
To Print/ Cancel | File TDR of your Transactions done before 20-Sep-2015 Click here
Cancel Ticket > Cancel Ticket Booked Ticket History (New) €<—{ Check History
Booked Ticket History (Old and
Refunds Mobile App)
TDR Print Ticket < Print Ticket
Welcome SUGATA BHATTACK
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Getting started with MS Word

D
Start > All Program > Microsoft Office > MS Word 2013 /2010 /2007

L ACLY Training
b CCleaner
i FasterPC Teacher
Games
. Google Chrome Documents
) IDEA
). Maintenance
I Microsoft Office
[-R] Microsoft Access 2010
,i’l Microsoft Excel 2010
|I| Microsoft InfoPath Designer 2010
|ﬂ Microsoft InfoPath Filler 2010
IM Microsoft OneNote 2010
0| Microsoft Outlook 2010
[B] Microsoft PowerPaint 2010
_ﬂ] Microsoft Publisher 2010

B b PR

Pictures
Music
= Computer
Contrel Panel
Devices and Printers

Default Programs

| W] Microsoft Word 2010 Help and Support
T T ey emaiiy
. Module Test Advance ITT 100Hrs
Back

Page Layout  References  Madng: Brview  View — - . — :-'
) AW A & E-EGE REONT | saabconc | assbcax AaBbC AaBbce AQD assbee r
P matpuni B 7 DNk WA TR W B G- | tnome [rhosec. Mesingl tesdegd  Te  subne o Cange BT Ribbon Area
Quick Access
Toolbar
Blinking Cursor
(for Start
Typing) Main Working
Area
(Page)
/ :
Pagelofl | Werdsd | & EEE 3. Lo o 5 . Status Bar
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Editing and formatting document

Text formatting

> Select a Text > Home Tab > Font Group = Click the following Icons

| Home I Insert Page Layout References Mailings Rey
oW calibri (Body) -1 - |A A || %)|
=3 Copy =

F Format painter || B | Z B - sbe 3, x' Aa-||®” - A

Clipboard ) Font =

Option Used For Icon
Bold To Bold B J
Italic To Italicize

N

Under Line To Underline

s
To change case (Upper,
Change Case [ T ]

Lower etc)

Paragraph Formatting
> Select a Paragraph’=> Home Tab > Paragraph Group = Click the

following Icons

Home | Insert Page Layout References Mailings Review View

depGut calibri (Body) sha | A T ||§:)_| li= -~ i= ,'t.‘:_,| = ﬁEH%I“?‘

ool . | ) ==y ]| S
-

v-A- == =8z

- Format Painter |B|I U - abe x, x* Aa-|

wl

ipboard E Font e Paragraph

Option Used For Icon

I
il
il
]

Allighment | Change Allignment

Spacing To Change Line

+
1}

Spacing

! *paragraph is created by pressing enter key.

2 50/50)
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Example of Text and Paragraph Formatting

Plain text before formatting :

A quick brown fox jumps over the lazy dog. (Default formatting)

| Home Insert Page Layout References Mailings Review View Add-Ins

Cut ) & _— I _ o e
h Times NewRom* 18 * A A"  Aa~ ﬁ}} ISy S e tioy | EEEE AL q
j Copy

é@ ’ v 307 . v g E = = *‘= v iiiw
FFormat Painter B | Z10-~ X, v-A-| = = = D~

board . Font Paragraph M |
Formatted Text. 1 \I;

A quick brown fox jumps over the lazy dog.

(After Appling text and paragraph format)

50/50)
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Track Change:

To keep a Track of changes that is made to a document. Following are the steps.

Activate Track Change Option
Open the document = Review tab—> Tracking Group—> Track Changes—> Track Changes

Insert Png'r Ill,uu‘t References Mailings W Add-Ins

@ T r —
I I a @ ] = | | | E o |T@& Finak Show Markup - :% #} Previoud
g Ed; L 23‘] 5 A A Show Markup ~ I B3 Next
Spelling & Research Thesaurus Word | Translate Language New Delete Previous Next Track Accept Reject
Grammar Count - - Comment Charlqu'_E Reviewing Pane ~ - -
Proofing Language Comments 'J‘} Track Changes | Changes

P E

Ll LEE.IIE Track Changes (Ctri+Shift+E) ?:?
Track all changes made to the

document, including insertions,
deletions, and formatting changes.

0 P o [

Now Make the Changes and see the result

Insert Page Layout References Mailings | Review View Add-Ins
e ABC g% %5_- p - = y B, 9% Final: Show Markup 2 I Lo 48} Previous j ]
|_|_' | ; s ~3 A 75
123 5 & Q -—j ‘—J ‘—J = 3 show Markup ~ = e 2} Next @
esaurus Word | Translate Language New Delete Previous MNext Track Accept Reject Compare Block
Count - - Comment Changes = [B] reviewing Pane ~ - Authors
1] Language Comments Tracking Changes Compare Protg
RS R S DS OO, O OIS SO e
¥ ¥ y ¥ v T ¥ ¥ T T T v
On the Insert tab, the galleries include items that are designed to coordinate with the overalllookof .- {F 3: Font: Bold ]
your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and
other document building blocks. When you create pictures, charts, or diagrams, they also coordinate .-~ { Formatted: Font color: Red |
sibyourcummangdooumangiogls - e o e e e s -~ {F d: Double underline )

If you want to accept/reject the changes, do the following
Go to Review Tab—>Changes Group = Accept/Reject Option

[ Review | View Add-Ins

J 3 i:j "3‘._; Final: Show Markup @ @ #% Pevious

2} show Markup ~ P NExt
te Previous Mext Track Accept Reject
Changes ~ E Reviewing Pane ~ - -
mments ‘ Tracking Lhanges
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Page Setup & Printing

Page Setup:
Under this menu we can change the Margins, The size (format) of the paper, the orientation etc.

Step: Page Layout Tab > Page Setup Group > Margin /Orientation/Size

Home Insert II Page Layout References
e 0 B O

]ants'
Margins Orientation Size Cdlumns
| Effects ~ v ~ |-
J

Page S
/ N W.P‘

References Mailings

e Layout References Ma Layout | References Mallings Ref
1 I j . V= Break ¥= Breaks i‘“l Ij (58 '5_: E"’:‘ ” .
: é £ Line N i3 Line Numbe ration ESERM Columns. s wphenstion +
Orientation  Size  Columns pa Orientation| Size Columns o ) [T— | Letter )
v v +  be Hyph - - +  be Hyphenatio | F | 8.5 x11°
|. N _—] ) TaM_
Top: 1° Bottom: 1 i Portrait 11°%17
Leftt 17 Right 1° - Legal
| _J B.S5 x14"
Narrow —|  (Executive
Top: 05 Bottom: 0.5° =] Llandscape [ 72s°xios
Left: 0.5 Right: 0.5° [ A3
g J 11.69" %16.54"
Moderate _] ;:?' % 11,69
Top: 1° Bottom: 1°
i . - B4 (1S)
Left: 075 Right 0.75 A taag
BS UIS)
Wide 717" x10.12°
Top: 17 Bottom: 1°
left: 2 Right: 2" Gres
Envelope Monarch
_ Mirrored 388" x75
TGP: r BOﬁqm: r More Paper Sizes...
Inside: 1.25 Qutside:1”
Office 2003 Default
Top: 17 Bottom: 1°
Left: 125 Right: 1.25"
Custom Margins...

Try the above and see the effect in your document
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Printing :

50 : 50 Technology for Senior Professionals

In MS- word application Printing in not a critical issue. Just make sure that you have properly
selected the page setup related option as shown above (especially Paper Size).

File Tab 2

Print 2

Finally

Click to Print’

MS Word 2010

On the Insert tab, the galleriesincludeitems that are designed to coordinate with the overall look of your document.
You can use these galleriesto insert tables, headers, footers, lists, cover pages, and othar document building blacks.
When you create pictures, charts, or diagrams, they also coordinate with your current document look.

You can easily change the formatting of selected text in the document text by choosing a look for the selected text
from thie Quick Styles gallery on the Home tab. You can als format text directly by using the other controls on the
Home tab. Most controls offer a choice of using the look from the current theme or using a format that you specify

directly.

To change the overall Iook of your document, choose new Theme elements on the Page Layout tab. To change the
looks awailable in the Quick Style gallery, use the Change Current Quick Style Set command. Both the Themes gallery
and the Quick Styles gallery provide reset commands so that you can always restore the look of your documant to

the original contained in your current template.

On the Insert tab, tha galleriesincludaitems that are designed to coordinate with the overalllook of your document
You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks.
When you creste pictures, charts, or diagrams, they also coordinate with your current document look.

You can easily change the formatting of selected text in the documant text by choosing a ook for the selected text
from the Quick Styles gallery on the Home tab. You can also format text directly by using the other controls on the
Home tab. Most controls offer 8 choice of using the look from the current theme or using a format that you specify

directly.

To change the overall look of your document, choose new Theme elements on the Page Layout tab, To change the

Check your Page Setup’

— - il Current Quick Style 52t command. Bath the Themes gallery
that you can slways restore the look of your document to

I Seve .
Print
ﬂ Save As g
e Copied 1 :
2 o
i Then Print
'L'J Close
" .2
S Printer Number of Copies
J Send To Onehvorezome =
Recent = Ready
N Printer Properties
EW
Settings
print 1
- Print All Pages -
“__| Print the entire document
Save & Send
Pages:
Help J Print One Sided =
4 Only print on one side of the page
] Options
ollated
R 3 123 123 '
- 3\
J Portrait Onientation ¥
1 A
8.27° x11.69
Narrow Margins < >-
t—d Left 05" Right 05
J 1 Page Per Sheet -

J
Page Setup

|

1

ofl b

- Ened to coordinate with the of your document.
You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document bullding biocks

When you create pictures, chars, or diagrams, they also coordinate with your current document look
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Few simple MS Word Shortcuts

1.Bold =

2.1talic>

3. Underline =

4. Save =

5. Print 2

6. New =2

7. Undo Last Transaction—=>

8. Redo Last Transaction =

Ctrl | + B

‘ Ctrl + ‘ |
‘ Ctrl ‘ + U ‘
‘ ctrl 4+ S

CIE
EINES

Ctrl E3 Z

Ctrl + Y

39



Getting started with MS Excel

Start Menu —)AII Program - Microsoft Office = MS Excel 2013/2010/2007

. Accessornies

. CCleaner

. Games

. IDEA

. Maintenance

. Microsoft Office

ﬂ-\-] Microsoft Acce_ss 2010

i7| Microsoft Excel 2010

4 Back

X |
1 icrosoft InfoPath Designer 2010

Ii| Microsoft InfoPath Filler 2010
[El Microsoft OneNote 2010
O | Microsoft Outlook 2010
[B] Microsoft PowerPoint 2010
(B] Microsoft Publisher 2010
| 5] Microsoft SharePoint Workspace 201
[W] Microsoft Word 2010
L. Microsoft Office 2010 Tools
I Microseft Visual Studic 6.0
\. Microscft Web Publishing
I. Module Test Advance ITT 100Hrs

Teacher

Documents

Pictures

Music

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

Formulas Data
A A S = ®
- A- EES
5] Alignment
E

Home

é ‘:" Calibri
Pa;; o B I 1 -~

- 7 ==
Clipboard s

Al

| A B
|
2 {
3 {
% 4
] 4
6 4
7 1

Row |—= |&

s |
10 |
11 |
12 |
13

14 |

15| . - -

4 4 » ¥ |[fSheetl ) Sheet2 - Sheet3 -~ ¥J
v

N

The above is an example of excel workbook which consists of worksheet and each worksheet consists of
horizontal and vertical line, known as row (represented by number) and column (represented by
alphabet(s)) respectively ,the intersection point of which is cell (A2,B5 etc.).

40

Sheet Tab

50 : 50 Technology for Senior Professionals

Work efficiency using MS Excel

$ - % -+ | <l %%

CELL
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Formating Data in MS Excel

Step 1: Start by entering data (text, number or date) in cell of an excel worksheet as per example

given below:

Home | Insert  Pagelayout  Formulas Data Review  View  Developer
C t - - — re=n
j & Cu Calibri 11 A A= == = Wrap Text General -
; : 153 Copy ~ B A "_ o oh
'aste - o - - = = = iF iF v O .0 .
< < Format Painter B 7 U L2 = = = | iE = | Bl Merge & Center~ | § % v | o s0
Clipboard s Font | Alignment s Number
F8 v I

| A | B | C | b | E | F | e
LWORK EFFICIENTLY USING EXCEL
2 3ANK NAMLCHEQUE NC AMOUNT
3Cac D 123589 (50000
4 sBl (478523 85000

3 5 4

Formatting features Improve and change the appearance of data

Step 2: Select the cells=> home tab—> font group—>Apply the following formatting effect and see the
result

a) Wrap text

b) Merge and Center

c) Apply border

d) Increase or decrease the decimal place for Numbers

| E B - —
File | Insert Page Layout Formulas Data Review View Developer
| j % Cut Calibri 11 v A A = General -
;' . 53 Copy ~ Ak =
aste v v v y | = _— b .
v J Format Painter B 7 U 52 fEnd = $ Yo ? b 5.0 |
Clipboard 1 Font | Number
G11 - £ |
| | I iy

WORK EFFICIENTLY USING EXCEL —> ERGE & CENTER
SANK NAMEHEQUE NG AMOUNT

(ICICI 123589 50000
SBI 1478523 85000

| INCREASE DECIMAL |

- | >! WRAP TEXT
| AUTO FIT

0N O U EA WN R

55150 .
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Home | Insert Page I.ayout.

Developer

50 : 50 Technology for Senior Professionals

iﬁ °§ e Calibri -1 AAxN SFE== ¥  SiwapTet General
“— B3 copy ~ R I | (==
ERgte Fromatpainter B £ U~ H-| &-A- E= = |iEE EMergeaCenter~ | § - % » | % 5%
Clipboard Font | Alignment Number -
c7 - (= |
| A [ 8B [ c 1 b | E F_ | 6
1  WORKEFFICIENTLY USING EXCEL
CHEQUE
BANK NAME 9 AMOUNT
2 NO
-3 |ICICI 123589| 50000.00
4 SBI 1478523 85000.00
5

Getting Totals & Summarizes

Functions & Formulas: In-built functions and formulas are used for performing simple and complex

calculations.

Excel can be used for the purpose of getting summary of a range of cell. The example of which is Sum,
Average, Max & Min of a range. For this you simply need to select the range (which you want to
calculate like (c3:c4) first and then select the necessary function as shown below

Home 'I'nser‘t Page 'la)rou‘t - Formulas Data . % %— i.:j
L ;E:’Y' i AN | = Z | | Insert Delete Furma.t &
Paste : BJZU- H- &-A- E it 7 ¥ ' Average it
. .j — Pﬂmtei | Cells ‘ Count Numbers |
Clipboard Font 7/ =
c3 G | 50000 / Max
A B e | / J Min
1 WORKEFFICIENTLY USING EXCEL / More Functions..
CHEQUE
BANK NAME AMOUNT
2 NO
3 |[ICICI 123589| 50000.00
4 SBI 1478523 85000.00
5 135000.00
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n_ Home Insert Page Layout Formulas Data Review View Developer
.;~ * tut » 113 - A A Eas=|® __j Wrap Text Number -
! 3 copy ~ o —
Paste oy comatpanter | B £ U - [ - &- A-|EX || Emegeacente-| $ - % 1 | %83
Clipboard Font Alignment Number
SUM + (" X « f&| =sum(ca:ca)
A B C D E ; G
1  WORKEFFICIENTLY USING EXCEL
CHEQUE
BANK NAME AMOUNT
2 NO
3 |ICICI 123589| 50000.00
4 SBI 1478523| 85000.00
5 =SUM(C3:C4)
6

Excel Charts to make your Client smile

Data can be viewed in graphical form, such as charts, to analyse & compare data

The steps to create :

Step-1: Select the whole table including header row and column.( you can use ctrl+A after keeping

cursor at any part of the table)

Review View ‘Developer

Page Layout Formulas

F EHEER DR e S Sy ) 2 e
PivotTable Table Picture Clip Shapes SmartArt Screenshot] Columnj Line Pie Bar Area Scatter Other Line Column Win/Loss
- Art - - - - - . - *  Charts~
Tables Mustrations Charts Sparklines

_ A2 i - | MONTH _ _ _

4] A ] B [ c | D [ £ [ F | G

1 MONTH AND ZONE WISE SALES DATA FOR PRODUCT Z (RS.cr)
2 IMONTH EAST CENTRAL WEST NORTH SOUTH
| 3 [JANUARY Rs.560.00 Rs.900.00 Rs.640.00 Rs.840.00 Rs.750.00
4 [FEBRUARY Rs.670.00 Rs.650.00 Rs.340.00 Rs.980.00 Rs.860.00
5 IMARCH Rs.630.00 Rs.320.00 Rs.550.00 Rs.330.00 Rs.730.00
| 6 |APRIL Rs.490.00 Rs.870.00 Rs.720.00 Rs.200.00 Rs.180.00

7 IMAY Rs.890.00 Rs.670.00 Rs.440.00 Rs.590.00 Rs.300.00

50/50)
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Insert Page Layout Formulas Data Review View Developer
P EED 2 & (e D Q &
PivotTable Table | Picture Clip Shapes SmartArt Screenshot | [Column| Line  Pie Bar  Area Scatter Other Line
- Art - - - - - ~ - ~  Charts~
Tables Illustrations 2-D Column I
A2 - (= f« | MONTH ol |
T 1 < dal|=8] 88 —
1 MONTH AND ZONE WISE SALEY ;. p| Clustered Column .cr)
2 MON"I'I_I EAS'I‘ (:EIQ"I‘RAL [ Compare values across categories SOU'I'I_I
== by using vertical rectangles,
3 (JANUARY Rs.560.00 Rs.900.00 Rs.750.00
— Use it when the order of categories
4 [FEBRUARY Rs.670.00 Rs.650.00 is not important or for displaying  RS.860.00
= item counts such as a histogram.
| 5 IMARCH Rs.630.00 Rs.320.00 s8.730.00
| 6 [APRIL Rs.490.00 Rs.870.00 m J‘B‘B‘ ]J-!H- ﬂﬂ Rs.180.00
7 MAY Rs.890.00 Rs.670.00 Rs.300.00
8 = Tl il &
A m. Jad| JAA] B4
n Home Tnsert Page Layout Formulas Data Beview View Developer Detign Layout Formst | -
all W, =
R Type Tempiate | Row/chiomn Dats j,n“ J &) ‘h ‘ | L ‘ |h * |L ‘ ‘ L ‘ L ‘ L ‘ |
Type Data Chart Layouts Chart Styles
Chart 2 - £ | B N
A B c D E F G H 1 1
1 MONTH AND ZONE WISE SALES DATA FOR PRODUCT Z (RS.cr) -
2 MONTH | EAST  CENTRAL __ WEST NORTH soutH | “We®
s TANUARY | Rs.560.00 Rs.900.00  Rs.640.00 Rs.840.00 Rs.750.00 || gs1000.00
s FEBRUARY | Rs.670.00 Rs.650.00 Rs.340.00  Rs.980.00 Rs.860.00 ||
5 MARCH Rs.630.00 Rs.320.00 Rs.550.00  Rs.330.00 Rs.730.00 R5.800.00 ®IANUARY
5 APRIL Rs.490.00 Rs.870.00 Rs.720.00  Rs.200.00 Rs.18000 || | w N B le - ] B W vy
7 MAY Rs.890.00 Rs.670.00  Rs.440.00  Rs.590.00 Rs.300.00 [| ® MARCH
g Rs. 200,00 -+ - — . - - .- — . APRL
El | = MAY
Lo Rs. 200,00 -
& Rs.0.00 T T T T 1
L2 / EAST CENTRAL WEST NORTH SOUTH
E]
Pie chart
I Home :i Insert Page Layout Formulas Data Review View Developer
' '5 & Cut Times New Roman ~ 14 ~ A" A7 = =|=| ¥~ = Wrap Text
3 copy ~ I A
Pa'ste 9 Format Painter B 7 U~- H~- &~ A-~ S E=E £ a3 Merge & Center
Clipboard = | Font = | Alignment U
A2 - (= £ | MONTH
A [ B I C | D | E | F | @
SALES FIGURE OF PRODECT "Z" IN DIFFERENT REGION FOR THE MONTH OF JANUARY(RS in cr)
MONTH EAST CENTRAL WEST NORTH SOUTH
JANUARY Rs.560.00 Rs.900.00 Rs.640.00 Rs.840.00 Rs.750.00

The process as stated above can be used to create a pie chart too with one difference i.e. Chart Type

will be “Pie”
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| Insert 'Page Layout Formulas Data Review View Developer

= e i EE e J = e =
i3 bl BE P 2 ol gl XD Tl D B e [H
PivotTable Table Picture Clip Shapes SmartArt Screenshot | Column  Line Pie Bar Area Scatter Other Line Column Win/Loss Slicer

- - - - - - - - - chans-

Tables Tllustrations | 2-D Pie I Sparklines Filter |

A2 - (= % | MONTH 1

4| A | 5 | € | D | E 1 J K

1 SALES FIGURE OF PRODECT "Z" IN DIFFERENT REGION FOR THE MONT
MONTH EAST CENTRAL WEST NORI
JANUARY Rs.560.00 Rs.900.00 Rs.640.00 Rs.840

Display the contribution of each
value to a total.

Use it when the values can be

added together or when you have
only one data series and all values
are positive.

e IS w]m

Chart Tools

Home  Inset  Pagelayout  Formulas  Data Review  View  Developer Design | Layout | Format

IR

Chart Area || (W - (= N [wl L& |
b @ B & e e ] [
% Format Selection
Picture Shapes Text Chart Axis Llegend Data Data Axes Gridlines | Plot Chat Chat 3D
ﬁResettDMatchStyle A Box | Titler Titles v  labels ~ Tahle Area~ Wall~ Floor ~ Rotatio
Current Selection Insert Labels Axes Background
Chart1 v @ fe
4 A | 8 [ ¢ | o | e | ¢ [ e | ®w [ 0 |

1 |SALES FIGURE OF PRODECT "Z" IN DIFFERENT REGION FOR THE MONTH OF JANUARY(RS in cr)

2 MONTH EAST CENTRAL WEST NORTH SOUTH
3 JANUARY |Rs.560.00 Rs.900.00 Rs.640.00 Rs.840.00 Rs.750.00

a4
S | JANUARY
6|
7|
8
3 |
—0- BEAST
1 W CENTRAL
1| o WEST
13 BNORTH
4 ¥SOUTH
15
16
17|
18 -

5DI5® e



46

Steps involved :

_I_>age Set up & Printing

50 : 50 Technology for Senior Professionals

Step 1: Select data to be printed—>Page layout tab = page setup group—=> print area icon=> set print

area
Formulas Data
E [A nColors' @ '_J
. ﬁ Fonts - ! Q |h
' Themes Margins Orientation Size Print |[Breaks Background Print
- [O]Eeffects ~ - - ~ | Area~ Titles
' Themes Pabl % set Print Area £
: Al - J< | SALE Clear Print Area
' 50 101|VUAY 20|GUNJAN 3376
' 51 102|PRAMOD 23(AMIT 100000
| 52 102|PRAMOD 24|SOURAV 8464
' 53 102|PRAMOD 25|AMRITA 3811
| 54 102|PRAMOD 26|KUNAL 8558
' 55 102|PRAMOD 27|DEBOJYOT 6347
| 56 102|PRAMOD 30|SUSMITH 6300
' 57 102|PRAMOD 32|UTTAM 2296
| 58 101|VUAY 11|ANKIT 6482
' 59 101|VUAY 12|RAHUL 2912
| 60 101|VIJAY 13|RISHI 4034
61 101|VIJAY 14|RONY 8251
| 62 101|VIJAY 15|NEHA 4160
' 63 101|VUAY 16|PUJA 7966
| 64 101|VUAY 20|GUNJAN 3376
| 65 102|PRAMOD 23|AMIT 100000
6 66 102|PRAMOD 24{SOURAV 8464
' 67 102|PRAMOD 25|AMRITA 3811
| 68 102|PRAMOD 26|KUNAL 8558
| 69 102|PRAMOD 27|DEBOJYOT 6347
| 70 102|PRAMOD 30|SUSMITH 6300
71 102|PRAMOD 32|UTTAM 2296
' 72 101|VIJAY 11|ANKIT 6482
' 73 101|viIAY 12|RAHUL 2912
' 74 101|VUAY 13|RISHI 4034
' 75 101|VUAY 14|RONY 8251
| 76 101|VIIAY 15|NEHA 4160
77 101|VIJAY 16|PUJA 7966
| 78 101|viIAY 20|GUNJAN 3376
' 79 102|PRAMOD 23(AMIT 100000
801  102|PRAMOD 24[SOURAV
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Step 2 : Set heading Row in case of multiple page print—>click the raised button = open page set up
dialog box—> go to sheet tab—> select row to repeat

Insert Page Layout Formulas Data Review View Developer Design
| By = ] = 51 Width: Automatic v Gridlines  Headings | | W
J —I = |—] -":’::J ' = _.J 4] Heignt: Automatic v | [¥] view | [¥] view - “a
Themes — Margins Orientation Size Print Breaks Background Print o . Bring Send  Sele
|9 Effects Area [ ey 100% . Print ' L | Print | Forward + Backward -  Pa
Themes Page Setup . Scale to Fit Sheet Options a Arrd
AL +( &[saeso \
al__A J E—— o (5820, 9 ST (R ST R TR [T BT
1 SALES ID__|SALESMAN _[INVOICE NO _[NAME Nt |
2 101|VIIAY 11|ANKIT Page Setup =)
3 101{VIJAY 12|RAHUL BN .
4 101{VUAY 13[RISHI 4034) | Margis | HeaderfFooter | Sheet |
5 101{VUAY 14[RONY 851 1| | e SN\ Tae
5 101{VIJAY 15|NEHA T {1 — -
7 101|VIIAY 16(PUIA 7966 -
1 Rows to repeat at top: 2 | $1:61
8 101|VIIAY 20|GUNJAN 3376] =
9 102|PRAMOD 23/amIT 100000) | | S orepeotatleft
10 102|PRAMOD 24|0URAV a4 ||| Pt
11 102{PRAMOD 25|AMRITA 3811 ] Gridines Conments: | (None) B
12 102{PRAMOD 26/KUNAL 8558 D Backand whie il s [torsd &
13 102{PRAMOD 27|DEBOJYOT 6347, ||| [Doraftquaity -
14 102|PRAMOD 30|SUSMITH 6300 ] Row and column headings
15 102|PRAMOD 32|UTTAM 2296] ||| Pace order
16 101{VIJAY 11]ANKIT 6482] ||| @ Down, then over
17 101{ViJAY 12|RAHUL 2912) © Oyer, then down
18 101(VIIAY 13[RISHI 4034
19 101|VUAY 14[RONY 8251]
2 101|VuAY 15|NEHA 4160]
2 101[VUAY 16{PUIA 7966 [ pint.. | [Printpreview | | Options... |
2 101 VUIAY 20|GUNJAN 3376] |
23 102{PRAMOD 23/amiT 100000] [ ok ][ concel |
24 102{PRAMOD 24/SOURAV 3464
= P v = P — —_—
2% 102{PRAMOD 26|KUNAL 8558]
27 102|PRAMOD 27|pEBOIYOT 6347
28 102|PRAMOD 30|SUSMITH 6300
29 102|PRAMOD 32|utTAm 2296
30 101{ VLAY 11|ANKIT 6482
3l 101/VUAY 12|RAHUL 29
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Final Step : File Button—> Print Option—> Click on Print Icon to Get Hard Copy
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Developer

Design

|
wsay
101[VUAY 12[RAHUL 2912
101JVUAY 13|RisHi 4034
101[VUAY 14[RONY 8251
101} VUAY 15|NEHA 4160
101{vuay 16/PULA 7966
101[VuAY 20{GUNJAN 3376
102|PRAMOD 3[amm 100000
102|PRAMOD 24/S0URAV 8464
102|FRAMOD 25[AMRITA 3811
102|PRAMOD 26|KUNAL 8558
102|PRAMOD 27|neBoIvOT 6347
102|PRAMOD 30[susmmH 6300
102|PRAMOD 32[UTTAM 2296
101]VUAY 11[ANKIT 6482
101|VuAY 12[RAHUL 2912
101{vuay 13[RisHi 4034
101vuay 14|RONY 8251
101|vuay 15[NEHA 4160
101[vuay 16[PUA 7966
101]VuAY 20{GUNJAN 3376
102|PRAMOD 3lamm 100000
102]PRAMOD 24[s0URAV 8464
102|PRAMOD 25[aMRTA 3811
102|PRAMOD 26[KUNAL 8558
102{PRAMOD 27|DEBOIYOT 5347
102{PraMOD 30[SUSMITH 6300
102|PRAMOD 32[UTTAM 2296
101[VuAY 11[ANKIT 6482
101[VUAY 12[RAHUL 2912
101|VUAY 13[RISHI 4034
101vuay 14[RONY 8251
101|VUAY 15|NEHA 4160
101|VuAY 16[PUIA 7966
101{vuay 20{GUNIAN 3376
102]PRAMOD 23[amm 100000
102|PRAMOD 24[S0URAV 8464
102|[PRAMOD 25[|AMRITA 3811
102|PRAMOD 26/KUNAL 8558
102|{PrRAMOD 27[DEBOIYOT 6347
102|PRAMOD 30[SUSMITH 6300
102|PRAMOD 32|UTTAM 229
101|VuAY 11[ANKT 6482
101[VUAY 12[RAHUL 2912
101{VUAY 13[RisHI 4034
101JvuAY 14[RONY 8251

Home  Inset  Pagelayout  Formulas  Data  Review  View
] | ———
B saveas @
& Copies: 1 =
7 Open
» Print
[ Close
Info Printer D)
9/ HP LaserJet 1020 on DEMO-PC '
Recent <y, Offiine
Printer Properties
New
Settings
|' Print Active Sheets .
Only print the active sheets
Save & Send ol :
Pages: =| to ud
Help - Collated .
23 123 123
] Options
ﬁ Exit g Portrait Orientation b
D Letter b
85" x11"
~| Normal Margins i
= Left 0.7° Right 0.7
’E No Scaling .
| 11801 Print sheets at their actual size
Find more print settings
Page Setup
—— -

11 of2»
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Home Insert Page Layout Formulas Data Review View Developer Design

[ save
) Print
B save As @
Copiest 1 -
o || |
[ Close
Info Printer
@/ HP LaserJet 1020 on DEMO-PC i
Recent <, Offline
Printer Properties
New
Settings
——— Only print the active sheets
Pages: . to 3
Help D“_" Collated %
==1123 123 123
[ options E—
E Exit Q Portrait Orientation v
:J Letter 2
85" x11"

*| Normal Margins
t= Left: 0.7" Right: 0.7°
JQ No Scaling
[ 1100 Print sheets at their actual size

Find more print settings
Page Setup

SALES_ID SALESMAN INVOICE_NO %:1 E AMOUNT
TO1|VOAY T5|NENA 2
101|VUAY 16/PUIA 7966|
101{VUAY 20|GUNJAN 3376
102{PRAMOD 23)AmIm 100000
102|PRAMOD 24|SOURAV 8464
102{PRAMOD 25|AMRITA 3811
102|PRAMOD 26|KUNAL 8558
102{PRAMOD 27|DEBOIYOT 6347
102|PRAMOD 30/SUSMITH 6300
102|PRAMOD 32]UTTAM 22%
101[VUAY 11[ANKIT 6482
101|VUAY 12[RAHUL 2512
101 VUAY 13|RISHI 4034
101]VUAY 14[RONY 8251
101|VUAY 15|NEHA 4160
101|VUAY 16/PULA 7966
101|VUAY 20|GUNJAN 3376
102[PRAMOD 23[AMIT 100000
102[PRAMOD 24]SOURAV 8464
102[PRAMOD 25[AMRITA 3811
102[PRAMOD 26]KUNAL 8558
102|PRAMOD 27|DEBQIYOTI 6347|
102[PRAMOD 30/SUSMITH 6300
102|{PRAMOD 32|UTTAM 2296
101[VUAY 11[anKT 6482
101|VUAY 12[RAHUL 2012
101{VUAY 13[RISHI 4034
101|VUAY 14|RONY 8251
101|VUAY 15|NEHA 4180
101{VUAY 16[PUA 7966
101|VLAY 20|GUNJAN 33?6'
102|PRAMOD 23[AMIT 100000
102|PRAMOD 24|S0URAV 8464
102|PRAMOD 25/AMRITA 3811
102|PRAMOD 26|KUNAL 8558
102|PRAMOD 27|DEBOJYOT 6347
102|PRAMOD 30[susMmH 6300
102[PRAMOD 32{UTTAM 2256

|12 onI»l
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Few Simple Excel Shortcuts

Before concluding let us learn few shortcuts key that can make working with excel much
easier

i)  Ctrl+ X :To cut the data from present cell range to other cell range for example from
A2-C9 to D2-F9 or even to other sheet of same or different excel.

i) Ctrl + C:To copy data from a cell or range or cells

iii) Ctrl +V : To paste the copied data into another cell or range of cell in same sheet,
other sheet or any other place like MS Word, MS Powerpoint, etc

iv) F2:Edit Cell Contents
v)  Ctrl + 1: To open format cells dialogue box
vi) Alt + =:To add range of cells with numbers (Auto Sum)

vii) Shift + F11: Insert new Worksheet

50I50
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THE INSTITUTE OF CHARTERED ACCOUNTANTS OF INDIA

Name

Responsibility

Kasha Office

Russell Street Office

EMAIL

Dr. Alok Ray, Jt. Secretary (9330001192)

Decentralised Office - Head

30840277

30211102

alokray@icai.in

Mr. Abhijit Basu, Dy. Secretary (98306 64225)

In charge of Members & Articles

30840271

abhijit.basu@icai.in

Mr. Pallab Sarkar, Dy. Secretary (9230062227)

Decentralised Office

30840272

pallab@icai.in

MEMBERS SECTION

Mr. Pradip Sarkar, Consultant

Disputes, Query Redressal Fees Enquiry

30840296

eromem@icai.in

Mr. Arun Kumar Santra, Asst. Secretary

Fellow COP, Cancellation & Restoration of COP, Script
Certificate and Fees enquiry, CA. Main Exam

30840287

erofellow@icai.in;
eroexam@icai.in

Ms. Nandini Guha, Executive Officer

Enrollment of Associate Membership, Identity Card,
Script Certificate and fees enquiry

30840299

eroenroll@icai.in

Mr. Somnath De, Executive Officer

Merger, Networking, Reconstitution of Firms

30840288

erofirm@icai.in,

Mr. Soumen Mondal, DEO

Restoration of Name, Registration of Firms

30840289

erorestore@icai.in

ARTICLES SECTION

Mr. Utpal Basu, Consultant

Article Registration, Completion

30840257

utpal.basu@icai.in

Ms. Anindita Kundu, Sr. Executive Officer

Article Re-registration, termination, Other Courses,
Exam eligibility

30840265

eroart@icai.in;
anindita.kundu@icai.in

(A Shreya Lohia, Executive Officer

Registration alongwith other courses, Supplementary
Registration

30840256

shreya@icai.in

Ms. Sutapa Das, Executive Officer

Article Completion & Secondment

30840263

erocompl@icai.in

Mr. Pallab Ghosh, DEO

Registration, Industrial Training, ATC

30840259

eroreg@icai.in

Ms. Moushumi Bhadra Chatterjee, DEO

Article Re-registration, termination & Other Course

30840266

eroterm@icai.in

BOARD OF STUDIES

Mr. Bivas Kanti Dasqgupta, Consultant

Final & ITT Certificate, Campus Placement

30840242

erocct@icai.in

Ms. Susmita Sen, Student Counsellor (Gr. A.S.)

To know about CA Course, Student Programmes,
Campus Placement

30840239

erobos@icai.in

Ms. Sarmistha Biswas, Section Officer

Orientation Course, Mock Test

30840237

eircorient@icai.in

Ms. Piyali Chatterjee, DEO

CPT, IPCC

30840238

erocpt@icai.in

Mr. Kaushik Bhattacharjee, DEQ

IPCC, CPT, Revalidation

30840241

eroipcc@icai.in

Mr. Swarup Karmakar, LDC

Distribution of Study Materials

30840243

eroitt@icai.in

Post Qualification Courses (PQC) CELL

CA Debasish Sen, Asst. Secretary

Co-ordinator and Nodal Officer of all Post
Qualification & Certificate Courses, Computer Centres
& Publication

30211117

ero@icai.in

CALCUTTA COMPUTER CENTRE

Ms. Malini Sinha Chowdhury, Sr. Faculty

In Charge of Computer Centers.

30211142

malini.sinha@icai.in

REGIONAL COUNCIL

Mr. Kabir Ghosh, Consultant

Seminar information

30211134

eircpubn@icai.in

Mr. Pradyut Chakraborty, Consultant

Seminar information

30211104

Pradyut.chakraborty@icai.in

Mr. Saibal Krishna Chakraborty, Asst. Secretary

Seminar information

30211104

schakraborty@icai.in

Mr. Amit Paul, Assistant Secretary

Seminar information

30211133

eirc@icai.in, amit.paul@icai.in,

CA Manish Agarwal, Executive Officer

GMCS

30211260

eircgmes@icai.in,
manish.agarwal@icai.in

(A Jyoti Luharuka, Executive Officer

Website eirc-icai.org), Seminar information

30211108

jyoti.luharuka@icai.in

Mr. Santanu Bose, DEO

Seminar information, CPE Hrs.

30211108

eircevents@icai.in; eirccpe@icai.in

LIBRARY

Ms. Swati Banerjee, Librarian (Gr. A.S.)

In Charge of Library Section

30211103

eirclibrary@icai.in,
swati.banerjee@icai.in

SALES COUNTER / PUBLICATIONS

Mr. Avijit Roy, LDC

Sale of Books

30211101/47

psc_ero@icai.in
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